
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Intensity Pro 
Manuál 

Mac OS X™ 
 

Windows XP™ 
 

Listopad 2007 



Obsah 
 
 
Přehled 

2 
Obsah 2 
Vítejte! 3 
Seznámení s Intensity Pro 4 

 

 
Použití pro snímání a přehrávání 

 

 
Instalace pro snímání a přehrávání 5 
Aplikace jiných výrobců 8 
Blackmagic Design aplikace 15 
Podporované formáty souborů 22 
Problémy a potíže 23 

 

 
Schéma zapojení 

 

 
Typické nastavení Intensity Pro  24 
Zapojení Intensity Pro  25 
Monitoring s využitím Intensity Pro 26 
Nastavení pro Blackmagic On-air 27 
Snímání kompozitního videa z VHS přehrávače 28 
Snímání komponentního videa z videokamery 29 
Náhled komponentního videa v televizi 30 
Konektory Intensity Pro  31 

Zapojení Intensity Pro přes NTSC/PAL   32 

Zapojení Intensity Pro přes S-Video  33 
 

Záruční podmínky 
 

 
Dvouletá Záruční lhůta 34 

 
 
 
 
 
 

 



Vítejte! 
 
 
 
Děkujeme za zakoupení Intensity Pro. 

 
Doufáme, že se nám daří sdílet vaše sny o vytvoření video průmyslu, který je skutečně 
kreativním, díky umožnění přístupu komukoliv k video a zvukovým zařízením nejvyšší kvality. 
Intensity zahrnuje stejně kvalitní video technologie, jaké jsou využity u všech Blackmagic 
Design video karet, takže vaše kreativita nebude vskutku nijak omezena. 

 
Vždy jsem cítil, že by měl mít kdokoliv příležitost na sebevzdělávání a vyjádření své 
kreativity. Když tak o tom přemýšlíte, jsou kreativita, design a umění samou esencí humanity 
a je to to, co nás činí jedinečnými. Televize je úžasně kreativní medium, protože dodává 
našim smyslům vzrušující obrazové a zvukové vjemy, přičemž je divák dokáže jednoduše 
vstřebat. 

 
Až dosud vysoce kvalitní video vyžadovalo k vytvoření filmů, hudebních videoklipů, 
televizních reklam a seriálové produkce značně vysoké náklady na vybavení. Bohužel tak byl 
televizní průmysl chápán jen jako exkluzivní klub pro vyvolené. Jsem přesvědčen, že jednou 
z nejvýznamnějších věcí, jakých jsme v Blackmagic Design dosáhli, je to, že i nejvyšší kvalita 
videa je nyní dostupná pro všechny – takže nyní již můžete využívat svých kreativních 
schopností zcela bez omezení. 

 
Jsem opravdu šťasten, že vám k tomu může pomoci také naše nová karta Intensity Pro! 

 
Uživatelský manuál, který právě čtete, obsahuje veškeré informace, které potřebujete pro 
instalaci karty Intensity Pro, ale také další pokyny k jejímu využití, jako výkonného řešení pro 
editaci, založenou na HDMI, designu a efektech. Neváhejte věnovat čas přečtení manuálu, je 
zde spousta tipů a triků, jež vám mohou pomoci. 

 
Než si nainstalujete Intensity Pro, navštivte naše stránky podpory na www.blackmagic-
design.com a stáhněte si poslední update tohoto manuálu i SW ovladačů pro Intensity. Na 
stránkách podpory najdete další užitečné poznámky a také nové verze software a manuálu, 
který je v originále na CD, přiloženém ke kartě Intensity Pro. 

 
Na závěr si prosím, zaregistrujte sériové číslo své karty Intensity Pro, jakmile si stáhnete update 
ovladačů pro Intensity, abychom vás mohli upozornit, jakmile vyjde nová verze software. 

 
Budeme vám vděčni, pokud nám zašlete i ukázky vaší práce s Intensity a vaše postřehy, 
které nám pomohou vylepšit další verze software pro Intensity. Neustále pilně pracujeme na 
těchto nových vlastnostech a vylepšeních, takže se nám vaše názory budou hodit! 

 
 
Grant Petty 

 
CEO, Blackmagic Design 
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Seznámení s Intensity Pro 
 
 

Intensity Pro je vybavena poslední HDMI technologií pro záznam a přehrávání v nejvyšší 
kvalitě, v počítačích vybavených PCI Express, pod Mac OS X nebo Windows XP. Nyní můžete 
editovat s využitím velkoplošných HDMI televizí a video projektorů s HDMI, nebo snímat 
v nekomprimované kvalitě přímo z HDV kamer. 

 

Skutečné HDMI digitální propojení  

Intensity Pro je vybavena HDMI vstupem pro připojení kamer a digitálních set-top boxů, kvůli 
nejvyšší kvalitě záznamu. Nejvyšší možnou kvalitu záznamu získáte z HDV kamer tak, že 
sejmete obraz přímo ze senzoru a obejdete kompresní chip HDV. Protože editační software 
neumí přehrávat do HDV kamery kvůli monitoringu, Intensity je ideální k využití monitoringu 
nekomprimovaného HD, nebo HDV a dokonce i DV záznamu, na nejnovější, velkoplošné 
televize a video projektory zapojením do vlastního HDMI výstupu. 

 

Analogové propojení  

Intensity Pro zahrnuje i analogové video a audio propojení, ke snímání a přehrávání 
z analogových přístrojů. Můžete snímat z VHS nebo DVD přehrávačů přes NTSC/PAL vstup 
nebo přepnout na analogový Y,Cr,Cb a snímat vysoce kvalitní, komponentní video v SD nebo 
HD. Díky analogovému audio, můžete Intensity Pro napojit do VHS a S-Video strojů, DVD 
přehrávačů, set top boxů, HDV kamer a řady dalších přístrojů. Nyní můžete přehrávat v televizi 
a monitorech v NTSC/PAL , analogových komponentách nebo HDMI. 

 

Jděte za hranice HDV video kvality  

HDV video komprese nemá plné 1920 HD rozlišení a kvůli tomu je nutné další zpracování, 
které komplikuje editaci. Nyní můžete snímat i přehrávat v plném rozlišení HDTV 
nekomprimovaného videa a následně editovat ve skutečné broadcast a filmové kvalitě, což 
zcela eliminuje problémy s kvalitou HDV & DV komprese. 

 

Profesionální video standardy  

Možnost okamžitého přepínání mezi HD a SD video standardy, včetně HDTV 1080i/59.94, 
1080i/50, 720p/59.94, 720p/50, NTSC a PAL. Intensity Pro umožňuje snímání do 
profesionálních formátů souborů, které jsou plně kompatibilní s kartami DeckLink a Multibridge 
od Blackmagic Design. 

 

Kompatibilní s každým video software  

Intensity Pro je kompatibilní s QuickTime™ i DirectShow™, takže můžete využívat nabídku 
programů pro záznam a přehrávání video záznamů jak ve standardním, tak ve vysokém 
rozlišení 4:2:2. Můžete použít Final Cut Studio™ pod Mac OS X™ nebo Premiere Pro™ pod 
Windows XP™ k editaci, potom zkombinovat Adobe After Effects™ a Photoshop™ pro broadcast 
design a grafiku. Práci poté ukončíte pomocí programu na DVD authoring, takže klientovi 
předáte hotové DVD 

 

Kopírování chrán ěného videozáznamu  

HDMI video zdroje mohou mít na výstupu zakódovaný signál s ochranou proti kopírování. 
Z hlediska zákonů Intensity není určen ke snímání zdrojů s ochranou HDCP, jako je HDCP-
kódované video z DVD přehrávače. 
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Intensity Pro PCI Express karta. 
 
 
 
 
 
 
 
 
 
 

Intensity Pro break-out (redukční) kabel. 
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Instalace pro snímání a přehrávání 
 
 
 
Zapojení do PCIe Maca nebo PC  

 
1.  Vypněte počítač a odpojte napájecí šňůru ze zásuvky. Je to z důvodu bezpečnosti, než 

sejmete kryt počítače. Ověřte si, že máte vybitý statický náboj základní desky, např. 
dotykem radiátoru. 

 

2.  Sejměte kryt skříně počítače, abyste se dostali ke slotům PCI Express. 
 

3.  Vyjměte Intensity Pro kartu z ochranného statického váčku tak, abyste se nedotkli zlacených 
konektorů karty. 

 

4.  Najděte volný PCI Express slot v počítači, lhostejno který. Intensity Pro je karta typu PCI 
Express 1 lane karta a je kompatibilní se sloty typu PCIe 1,4,8 a 16 lane PCIe. Sejměte 
kovový kryt portu se šroubem na zadním panelu počítače. 

 

5.  Zasuňte Intensity Pro PCI Express kartu a ověřte, zda pevně zasedla s kliknutím do slotu. 
 

6.  Zajistěte kartu šroubem a vraťte kryt skříně počítače. 
 

7.  Zapojte HDMI zařízení, např. HDV kameru do HDMI vstupu Intensity Pro. 
 

8.  Zapojte HDMI kompatibilní, velkoplošnou televizi nebo projektor do HDMI výstupu. 
 

Pozn.: Nyní máte příležitost do počítače nainstalovat také diskové pole a přídavnou paměť. 
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Zapojte HDMI zařízení. 
 

 
 
 
 
Break-
out kabel 

 
 

Video Out 
 

 
Video In 

 
 
 
 
 

 
 
Zapojte HDMI zařízení. 

 
 
 
 
 
 
 
 
 
 
 

 
 

 
 
Použití pro snímání a přehrávání 



 

 

 

Instalace pro snímání a přehrávání 
 
 
 
Instalace software pod Windows XP  

 
Obsah  

Instalátor Intensity software nainstaluje následující komponenty:  
Ovladače Blackmagic Intensity. 
Ovladače pro snadné nastavení Premiere Pro™  
Blackmagic program Disk Speed Test pro testování disků 
Blackmagic Capture 

Pozn.: Před instalací jakéhokoliv software nebo hardware budete potřebovat oprávnění 
administrátora. Pamatujte, že aplikace jako Adobe Premiere Pro™ a QuickTime™ musíte 
nainstalovat ještě před spuštěním instalátoru Intensity. 

 
Intensity software  

1.  CD, dodané s kartou Intensity Pro obsahuje Intensity software. Před instalací ověřte, zda 
máte poslední verzi ovladače. Navštivte www.blackmagic-design.com/support 

 

2.  Vstupte do složky “Intensity Installer” a spusťte aplikaci “Intensity Installer”. 
 

3.  Klikněte na tlačítka Next,  Continue Anyway a Next, ovladače se nainstalují. 
 

4.  Nyní restartujte počítač, tím zprovozníte nové software ovladače. 
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Průvodce nastavením Intensity. 

 
 
 
 

Klikněte na “Pokračovat”. 
 
 
 
 
 
 
 
 

Restartujte počítač! 
 

 
 
 
 
 
 
 

 
 

 
 
Použití pro snímání a přehrávání 



 

 

 

Instalace pro snímání a přehrávání 
 
 
 
Instalace software pod Mac OS X  

 
Obsah  

Instalátor Intensity software nainstaluje následující komponenty:  
Ovladače Blackmagic Intensity. 
Blackmagic QuickTime™ kodeky. 
Easy Setups pro nastavení Final Cut Pro™  
Blackmagic program Disk Speed Test pro testování disků 
Blackmagic On-Air pro on-line produkci. 

 

Pozn.: Před instalací jakéhokoliv software nebo hardware budete potřebovat oprávnění 
administrátora. Pamatujte, že aplikace jako Final Cut Pro musíte nainstalovat ještě před 
spuštěním instalátoru Intensity. Pokud chcete použít přiložený On-Air software pro on-line 
míchání, musíte nainstalovat dvě Intensity karty, jelikož každá z nich zpracovává signál jiné 
HDMI kamery. 

 
Intensity software  

1.  CD, dodané s kartou Intensity Pro obsahuje Intensity software. Před instalací ověřte, zda 
máte poslední verzi ovladače. Navštivte www.blackmagic-design.com/support/software 

 

2.  Otevřete obraz disku “Intensity Installer” a spusťte aplikaci “Intensity Installer”. 
 

3.  Kliknutím na tlačítka Continue,  Agree a  Install nainstalujete do systému ovladače. 
 

4.  Nyní restartujte počítač, tím zprovozníte nové software ovladače. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Použití pro snímání a přehrávání 
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Komponenty instalátoru Intensity. 
 
 
 
 
 
 
 
 
 
 
 
 
 
Sledujte pokyny instalátoru. 
 
 
 
 
 
 
 
 
 
 
 
 
 
Restartujte Mac! 



 

 

 

Aplikace jiných výrobců 
 
 
 
Adobe Premiere Pro 2.0  

 
Adobe Premiere Pro™ je výkonná aplikace pro nelineární video a audio editaci v reálném 
čase. Plné presety pro Premiere Pro máte u Intensity Pro přibaleny a natáhnou se 
automaticky do systému během instalace. Premiere Pro musí být nainstalována v systému 
ještě před spuštěním instalátoru Intensity. 

 

Pozn.: Je-li potřeba, po instalaci Premiere Pro přeinstalujte Intensity software. 
 
Nastavení  

1.  Spusťte Premiere Pro. 
 

2.  Zvolte New Project 
 

3.  Vyberte vhodný Blackmagic preset pro svůj project, např.  NTSC nebo PAL 
 

4.  Zadejte jméno projektu. 
 

5.  Zvolte diskové pole, jako umístění pro media a klikněte na OK 
 
Přehrávání  

Zběžně zkontrolujte, zda je vše zapojeno správně, pomocí utility Premiere Pro test media 
(bars and tone). Zkopírujte testovací klip, který odpovídá formátu vašeho projektu, např. 
NTSC 8 bit. Přesuňte váš soubor z projektu Premiere Pro a vložte jej do časové osy. Nyní byste 
měli vidět obraz na desktop počítači i na HDMI výstupu z Intensity Pro. Jestliže nevidíte na 
výstupu z Intensity Pro, zkontrolujte znovu zapojení HDMI. 

 

Pozn.: displej připojený k HDMI již musí být zapnutý, než spustíte počítač. Je-li potřeba, 
restartujte počítač a ověřte, že Intensity Pro při nabíhání detekuje displej. 

 
Snímání  

Zvolte: File > Capture (F5) 
 

Kliknutím na červené tlačítko Record [G] spustíte nahrávání ihned. Pokud si přejete zadat klip, 
zadejte požadované body “In a Out” buď pomocí tlačítek “In” a “Out” nebo ručně, zadáním 
timecode a kliknutím na “Log”. V okně koše se nyní objeví prázdný klip. Operaci opakujte, až 
zadáte všechny klipy, které chcete přidat do seznamu Batch Capture. 

 

Pozn.: Pokud nevidíte zdrojový video signál, vypněte zdroj (např. kameru nebo stolní stroj), 
potom jej znovu spusťte a ověřte, že jej Intensity Pro karta detekovala. 
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Adobe Premiere Pro 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
Nový projekt. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Snímání.  

 
 

 
 

 
 
Použití pro snímání a přehrávání 



 

 

Aplikace jiných výrobců 
 
 
 
Adobe Premiere Pro  

 
Audio  

Intensity Pro je vybaven podporou ASIO audio ovladačů. To umožňuje Premiere Pro využít 
Intensity Pro jako ASIO audio zařízení. Jakmile poprvé spustíte Premiere Pro projekt, musíte 
zvolit audio zařízení, které chcete používat – buď Intensity Pro se dvěma audio kanály, nebo 
příslušnou zvukovou kartu. To můžete určit v Edit > Preferences > Audio Hardware 

Můžete také zvolit mix vícekanálového audio signálu v této nabídce. 
 
Ovládání za řízení 
Ovládání zvoleného běžného zařízení můžete konfigurovat v: 
Edit > Preferences > Device Control > Options 

 

Protokol: Nahlédněte do manuálu kamery nebo stolního stroje, kde je více informací o 
podporovaných protokolech. 

Port: Firewire port se objeví mezi dostupnými komunikačními porty.  

Time Source: Doporučujeme zvolit možnost VITC a LTC časového kódu zdroje.  

Timebase: Toto nastavení upravte jen, když měníte formát. 
Např. PAL 25 fps snímků za sekundu měníte na NTSC 29.97 snímků za sekundu. 
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Audio hardware. 

 
 
 
 
 
 

Ovládání zařízení. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 
Použití pro snímání a přehrávání 



 

 

Aplikace jiných výrobců 
 
 
 
Apple Final Cut Pro  

 
Apple Final Cut Pro™ je výkonná aplikace pro nelineární editaci video a audio v reálném 
čase. Vaše nová karta Intensity Pro ve Final Cut Pro umožňuje pracovat s každým video 
standardem, od DV až po nekomprimované 4:2:2 video v HD rozlišení. 

 
Položka “Easy Setups” u Final Cut Pro je přidána automaticky během instalačního procesu 
Intensity, pokud byl Final Cut Pro nainstalován předem. Proto je důležité nainstalovat Final 
Cut Pro ještě před instalací Intensity software. 

 

Pozn.: Je-li potřeba, po instalaci Final Cut Pro přeinstalujte Intensity software. 
 
Nastavení  

1.  Spusťte Final Cut Pro. 
 

2.  Objeví se obrazovka Easy Setup. 
 

3.  Klikněte na položku Setup for v nabídce a zvolte odpovídající Intensity Easy Setup. 
Pro každý TV formát (NTSC, PAL i HDTV) zde najdete řadu komprimovaných i 
nekomprimovaných formátů souborů, ze kterých si vyberete. Např., jestliže pracujete ve 
formátu NTSC, máte na výběr z následujících “Easy Setups”: 

Intensity NTSC Uncompressed 
Intensity NTSC - DV 

 

Zvolený “Easy Setup” bude částečně určen rychlostí diskového pole a částečně tím, zda již 
máte filmové klipy v konkrétním formátu. Pokud máte rychlé diskové pole, můžete si vybrat 
nekomprimované video s nejvyšší kvalitou. Jestliže máte jen jeden úložný disk, měli byste 
zvolit jeden z profesionálních komprimovaných formátů DV, DV50, DVCPRO HD nebo 
JPEG. JPEG často vypadá lépe, leč Apple dosud bohužel neimplementoval RT efekty pro 
JPEG. Jestliže tedy potřebujete RT efekty, pak DV, DV50 nebo DVCPRO HD pro vás bude 
lepší volbou. 

 

4.  Klikněte na položku nabídky Primary Scratch Disk a zvolte diskové pole z podnabídky. 
Potom klikněte na OK 

 

5.  Final Cut Pro je nastaven pro spuštění. 
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Final Cut Pro. 
 

 
 
 
 
 
 
 
 
 
 
 
 
Možnosti “Easy Setup”. 

 
 
 
 
 
 
 
 

 
 

 
 
Použití pro snímání a přehrávání 



 

 

Aplikace jiných výrobců 
 
 
 
Apple Final Cut Pro  

 
Přehrávání  

Pro rychlé ověření správného zapojení můžete využít Blackmagic testovací klipy (bars and 
tone), který najdete na instalačním CD. Najděte testovací klip, který odpovídá formátu 
vašeho projektu, např. 1080i/59.94 a zkopírujte jej na diskové pole. Importujte klip do 
projektu Final Cut Pro a přesuňte jej do časové osy. Nyní byste měli vidět obraz na desktop 
počítači i na velkoplošné TV, připojené k HDMI výstupu z Intensity Pro. 

 

Pokud nevidíte video na HDMI výstupu, ověřte znovu HDMI zapojení a za je správně 
nastavena konfigurace výstupu ve Final Cut Pro, v nabídce View > Video Devices. V téže 
nabídce ověřte, že je položka “External Video” nastavena na “All Frames”. 

 

Pozn.: displej připojený k HDMI již musí být zapnutý, než spustíte Mac. Je-li potřeba, restartujte 
Mac a ověřte, že Intensity Pro při nabíhání detekuje displej. 

 
Snímání  

Snímání spustíte v nabídce File > Log & Capture. (Command + 8) 
 

Video deck nebo kamera reagují stejným způsobem jako klip v časové ose, na klávesy 
“<mezera>”, “j”, “k” a “l”. 

 

Je důležité správně nastavit správně číslo pásky klipu. Snímání 

spustíte ihned  kliknutím na tlačítko Capture Now. 

Pokud si přejete přesné zadání klipu, zadejte potřebné body “in” a “out” klávesami “i” a “o” na 
klávesnici neboi ručně, zadáním v časové ose a klikněte na Log Clip. Pokud je označený 
box “Prompt”, Final Cut Pro se zeptá na jméno klipu. Po zadání jména klikněte na OK; klip se 
objeví v prohlížeči s diagonální červenou čárou, která značí stav “offline”. Operaci opakujte, 
až nalogujete všechny klipy, které chcete přidat do seznamu Batch Capture. 

 

Pozn.: Při snímání sekvence klipů z pásky, Final Cut Pro automaticky zadává jméno 
aktuálního klipu podle jména předchozího klipu. Takže, pokud byl první klip nazvaný “Mary, 
MCU”, Final Cut Pro nazve následující klip “Mary, MCU 01”, atd. Tak lze zadat velké 
množství klipů mnohem rychleji. 
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Logování a snímání. 
 

 
 
 
 
 
 
 
 
 
 
 
 
Logování klipu. 

 
 
 
 
 
 

 
 
 

 
 
 
Použití pro snímání a přehrávání 



 

Aplikace jiných výrobců 
 
 
 
Apple Final Cut Pro  

 
Snímání dávkov ě 

Vyberte klipy, které chcete snímat, přetažením nebo kombinací shift-click. V nabídce zvolte 12 
File > Batch Capture nebo klikněte na tlačítko Batch v záložce “Logging” v okně “Log & Capture“. 
(Control + C) 

 

Chcete-li přidat okna do klipu, zvolte v nabídce File > Batch Capture (Control + C). 
Označte box “Add Handles” pro snímání dalších oken (“handles”) před a za body “In” a “Out” 
klipu. 

 
RT Extreme Real Time Effects  

Efekty v reálném čase jsou další ze skvělých vlastností Final Cut Pro a s Intensity Pro jsou plně 
kompatibilní s RT Extreme™ od Apple. 

 
 

 
Dávkové snímání. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 
Použití pro snímání a přehrávání 



 

 

Aplikace jiných výrobců 
 
 
 
Adobe After Effects  

 

Je velmi snadné nastavit přehrávání a rendering v Adobe After Effects™ pro kompletní tvůrčí 
a designovou pracovní stanici, s podporou náhledu v reálném čase během práce na 
kompozicích. 
Nejdříve spusťte Adobe After Effects™  a zvolte standardní velikosti oken a jejich rychlost, podle 
toho, s čím chcete pracovat. 

 

Jak použít Intensity Pro jako Preview Output Frame Buffer  
Abyste mohli zobrazit Adobe After Effects kompozice v reálném čase na výstupu Intensity Pro, 
jděte do Edit > Preferences > Video Preview. Zvolte Blackmagic RGB a příslušný video 
standard. To umožňuje náhled na kompozice Adobe After Effects v barevném video prostoru na 
broadcast monitoru během práce. To znamená, že při práci vždy vidíte správné barvy i 
prokládání a nemusíte čekat, až se kompozice vyrenderuje, abyste viděli, jak vypadá na 
výstupu videosignálu. 

 

Vytvo ření nové kompozice  

V nabídce “Composition” zvolte Composition > New Composition. (Control + n v případě 
PC nebo Command + n v případě Maca). V dialogovém boxu zvolte příslušný televizní 
standard ve vyjeté nabídce. Klikněte na OK 

Pro všechny HD standardy zvolte nejprve horní půlsnímek. 
Pro NTSC a NTSC DV použijte 720 x 486 a nejprve zvolte spodní půlsnímek. 
Pro PAL 720 x 576 zvolte nejprve horní půlsnímek u 
nekomprimovaného videa.  
Pro PAL DV 720 x 576 zvolte nejprve spodní půlsnímek. 
Pro HD 1080i použijte 1920 x 1080 a zvolte horní půlsnímek. 
Pro HD 720p použijte 1280 x 720 a “none” v půlsnímku render boxu. 

 

Rendering  

Jakmile dokončíte svou kompozici, budete potřebovat renderovat pixelový formát, podporovaný 
u Intensity. Níže je výpis podporovaných kodeků: 

 

Blackmagic 8 Bit QuickTime™ (nekomprimovaný)  
Blackmagic 8 Bit AVI pro Windows (nekomprimovaný) 
Blackmagic Motion JPEG AVI pro Windows (komprimovaný)  
Apple QuickTime™ PhotoJPEG (komprimovaný) 
Apple QuickTime™ DV - NTSC (komprimovaný)  
Apple QuickTime™ DV - PAL (komprimovaný) 

 
 
 
 
Použití pro snímání a přehrávání 
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Adobe After Effects. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
Preferences. 



 

 

Aplikace jiných výrobců 
 
 
 
Adobe Photoshop  

 
Intensity Pro zahrnuje i plug-iny pro Adobe Photoshop™, takže můžete přímo snímat a poslat 
na výstup okna z aplikace Photoshop™ samotné. Jestliže pracujete s HD/SD, můžete 
dokonce importovat a exportovat 16-bitové obrázky Photoshop™

  v plné kvalitě. 
 

Import obrázku do Photoshopu  

1.  Ve Photoshopu zvolte File > Import > Blackmagic Image Capture 
 

2.  Vyberte “Video Input Format” a “Image Bit Depth” a zvolte Capture Image 
 
Export obrázku z Photoshopu  

1.  Zvolte File > Export > Blackmagic Image Export 
 

2.  Zvolte Video Output Format a potom Output Image. 
 

Pozn.: Jakmile nastavíte podmínky v okně “Export”, každý následující export již nemusí 
zobrazovat toto okno, takže výstup oken půjde podstatně rychleji. Samozřejmě, pokud 
chcete změnit formáty exportu, podržte u PC klávesu Alt nebo klávesu Option u Mac, když 
volíte export. 

 
Jak vytvo řit alpha kanály pro klí čování  

V sekci On-Air v tomto manuálu jsou informace o vytváření alpha kanálů v Adobe Photoshopu 
a příprava grafiky pro klíčování přes živé video. 
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Snímání obrázku. 
 
 
 
 
 
 
 
Export obrázku. 
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Blackmagic Design aplikace 
 
 
 
Blackmagic On-Air 2.0 pro Mac Pro  

 
Blackmagic On-Air je skvělá nová utilita, který využívá dvě karty Intensity jako on-line video 
mix, takže můžete jednoduše míchat signál dvou HDMI kamer, jako např. Sony HDR-HC3 
Handycam®.  
Pod Mac OS X Intel počítače nainstalujte dvě karty Intensity a získáte všechny výhody on-
line HD video produkce. 

 

On-line produkce vám dává okamžité výsledky, jelikož veškeré míchání probíhá naživo 
a jakmile jste hotovi, mát rovnou finální televizní program, připravený k vypálení na DVD 
nebo k distribuci na internetu. On-line produkce je mnohem snazší, než strávit hodiny 
v temné editační místnosti, takže i ti, kdo nemají hluboké zkušenosti se zpracováním videa, 
mohou dosáhnout profesionální video produkce. 

 

Bohužel, jedna z nevýhod nízkonákladové nelineární editace je to, že při živé televizní produkci 
se vytrácí umění! On-Air je perfektní, protože pro on-line produkci využívá NLE video karty. 

 

On-line produkce je zkrátka zábavnější. Neodlepíte se sice od židle a jinak to nejde, ale zato 
jste účastníky událostí, které editujete, jelikož probíhají přímo před vašimi zraky. Případné 
chybičky nejsou problém, protože můžete nahrávat rovnou na video pásku kamery a klipy tak 
máte zálohovány! 

 

Blackmagic On-Air je samostatné, dvoukamerové, televizní studio, vybavené kompletním 
prostředím jedné aplikace v okně na 20’’ monitoru počítače. Se dvěma kartami Intensity, 
nainstalovanými v počítači můžete zapojit dvě kamery s HDMI a máte tak náhled z kamer v 
oknech, společně s klíčováním a hlavním náhledem programu. 

 

Skvělé, nové a levné HDV kamery s HDMI výstupy znamenají, že kdokoliv s PCI Express 
Macem a monitorem s rozlišením 1600 x 1000 pixelů, může provádět SD nebo HD editaci. 

 

Prvním krokem je spuštění Blackmagic On-Air a otevření okna Preferences. Nastavte video 
formát, aby odpovídal výstupu kamer, např. HDTV 1080i/59.94 nebo 720p/50. Rozhodněte se, 
zda chcete snímat nekomprimované video, nebo v případě, že nemáte diskové pole, můžete 
snímat profesionální komprimované video, jako je DV, DV50, JPEG nebo DVCPRO HD na 
interní harddisk. 

 
 
 
 
 
 
 
 
 
 
 

 
 

Použití pro snímání a přehrávání 
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Blackmagic Design aplikace 
 
 
 
Blackmagic On-Air 2.0 pro Mac Pro  

 
Použijte dvě HDV kamery s HDMI výstupem. Zapojte kameru 1 do vstupu 1 karty Intensity a 
kameru 2 do vstupu 2. Pamatujte, že Intensity karta 1 má vždy přednost v PCIe slotu a má jako 
první přístup k CPU. (Viz obrázek na str. 27) 

 

Prostředí Blackmagic On-Air ukáže živé video z kamery 1 i kamery 2, zkombinované 
s monitoringem programu v reálném čase, v jednom okně. 

 
Snímání živého videa pomocí Intensity Pro  

1.  Spusťte Preferences > Video Format. Zvolte buď 720p nebo 1080i komprimovaného či 
nekomprimovaného videa, v daném počtu oken za sekundu. 

 

2.  Spusťte Capture Location. Pro komprimované video můžete zvolit interní disk, ovšem pro 
nekomprimované video budete potřebovat zvolit externí diskové pole. 

 

3.  Pojmenujte soubor záznamu. 
 

4.  Vyberte zdroj audio Intensity Audio nebo Intensity Audio 2 Tato volba umožňuje 
určit, která kamera bude mít preferovaný audio zdroj pro živý záznam, např. Camera 1 
s Intensity Audio, nebo Camera 2 s Intensity Audio 2. 

 

5.  Nyní zvolte mono nebo stereo audio volbou Channel 1 či Channel 2 

 

 
 

 

16 
 

 
 
 
 
 
Číslování karet Intensity. 
 
 
 
 
 
 
 
 
 
 
 
 
Zapojte kamery přes HDMI. 
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Blackmagic Design aplikace 
 
 
Blackmagic On-Air 2.0 pro Mac Pro  

 

Nastavení je nyní hotovo. Vyzkoušejte si přenos z kamery 1 do kamery 2, nebo mezi 
kamerami a černou (BLK), nebo přidat ke kameře grafiku (G). Kvůli plynulému přenosu mezi 
kamerami nastavte počet oken pro vysílání a stiskněte tlačítko AUTO TRAN. 

 

Střih mezi kamerami  

1.  Tlačítkem CUT provádíte rychlý střih mezi kamerami, nebo pomaleji ručně, pomocí T-páky 
mezi vstupy kamery 1 a kamery 2. 

 

2.  Kliknutím na tlačítko REC nahrajete smíchané video na disk. Kliknutím na STOP ukončíte 
záznam na disk. Uložené QuickTime filmy lze rovnou přehrát a přidat libovolné mixy, 
které máte připravené, včetně grafiky a vymizení. 

 

Automatický p řenos  

Jednou ze skvělých vlastností Blackmagic On-Air je to, že umožňuje přechod mezi kamerou 
1 a kamerou 2 pomocí CUT, ovládáním pomocí T-páky nebo prolnutím, nastavením určitého 
počtu oken přechodu mezi kamerami. 

 

Jelikož doba vysílání je nastavena v počtu oken, video, uložené v 720p, bude potřebovat 60 
snímků na jednosekundové prolnutí. Pro 1080i/59.94 budete potřebovat 30 snímků na 
jednosekundové prolnutí a pro 1080i/50, 25 snímků na jednosekundové prolnutí. 

 

Režim Easy A-B videomixu  

Blackmagic On-Air je vybaven nezávislými režimy míchání, ze kterých si vyberete podle 
svých zkušeností. Režim Easy A-B mixu je nejjednodušší a často volená metoda těmi, kdo 
s videem teprve pracovat začínají, jelikož je snadno použitelná. V režimu Easy A-B si 
vyberete jednu kameru do horního řádku a druhou do dolního, načež mezi nimi přecházíte T-
pákou nahoru a dolů. Pokud je T-páka nahoře, vidíte kameru, zvolenou do horního řádku a s 
T-pákou dole vidíte kameru v dolním řádku. On-Air je standardně nastaven v tomto režimu. 

 

Režim profesionálního videomixu  

Tento režim je založen na tom, že se v televizním broadcastingu využívá produkční obrazová 
režie a preferují ji lidé se zkušenostmi z profesionální on-line produkce. V tomto režimu je 
dolní řádek nazýván “programový” a horní pak “náhledový” (preview). Obraz kamery, kterou 
zvolíte v dolním řádku, bude vždy na výstupu. V horním řádku je kamera, zvolená pohybem 
T-páky nebo stiskem tlačítka Cut či Transition. Vyzkoušejte si, jak to funguje. Tuto metodu 
mixu preferují profesionálové, jelikož když běží on-line událost, víte, kterým tlačítkem získáte 
obraz kamery na výstup – je v dolním, programovém řádku. Tento režim míchání zajišťuje, 
že stále víte, co se děje na výstupu, i když právě probíhají jiné důležité události. 
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Video z “kamery 1”. 
 
 
 
 
 
 
 
 
 
 
 
 
Video z “kamery 2”. 
 
 
 
 
 
 
 
 
 
 
 
 
25 oken na vymizení. 
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Blackmagic Design aplikace 
 
 
 
Blackmagic On-Air 2.0 pro Mac Pro  

 
Jak p řidat grafiku nebo titulky  

Pokud chcete přidat logo ke snímanému videu, Blackmagic On-Air umožňuje vložit společné 
logo nebo titulky přes živé video. Třetí okno “kamery” je právě obrázek, který chcete vložit jako 
grafiku. Pokud tato grafika má alpha kanál, bude automaticky vloženo přes živé video. 

 

1.  Zvolte nebo vytvořte logo s alpha kanálem a uložte je ve formátu jako Photoshop, TIF nebo 
Targa, které podporují alpha kanál. Na následující stránce jsou pokyny, jak připravit grafiku 
pro video klíčování. 

 

2.  Drag and drop vložte logo na panelu Graphic, v Blackmagic On-Air. Logo se nyní objeví 
v okně dole vlevo, v Blackmagic On-Air. 

 

3.  Abyste mohli vložit grafiku, zvolte G pro grafiku pro “kameru 1” nebo “kameru 2”, podle 
toho, který zdroj potřebujete. 

 

4.  Nyní je grafika vložena přes obraz kamery. Opačným postupem se grafika vytratí. 
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Vložte logo nebo grafiku. 

 
 
 

 
Vložená grafika přes živé video. 
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Blackmagic Design aplikace 
 
 
 
Blackmagic On-Air 2.0 pro Mac Pro  

 
Jak vytvo řit alpha kanály pro klí čování  
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1. Otevřete logo ve Photoshopu. 2. Aby byla grafika dobře viditelná, vytvořte novou 
vrstvu, vyplňte ji bílou a pošlete do černé. 

 

 
3. Vytvořte duplikát vrstvy s logem. 4. Zvolte spodní logo a aplikujte filtr minimum. 

Tím lehce rozšíříte grafiku, takže se bude lépe klíčovat. 
 

 
 
 

5. Zvolte transparentní vrstvu horního loga příkazem 
nebo podržte Ctrl a klikněte na značku (thumbnail) 
vrstvy, pak klikněte na Save selection as channel. 

6. Proveďte příkaz Flatten a uložte s alpha kanály. 
Grafika je ve formátu RGBA pro použití v On-Air či NLE. 
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Blackmagic Design aplikace 
 
 
 
Použití Blackmagic Disk Speed Testu pro ov ěření disku (PC)  

 
Pokud chcete zkontrolovat rychlost diskového pole pro nekomprimované video, spuštěním 
Blackmagic Disk Speed Testu získáte kontrolu rychlosti pole a výsledek v počtu snímků za 
sekundu. Je to velmi užitečné pro pochopení, jak různá disková pole pracují při snímání videa 
a přehrávání v různém video rozlišení a při různém počtu oken. 

 

Disk Speed Test nabízí přesnější výsledky pro velká disková pole, jelikož testy rychlosti, 
dodané výrobcem se namnoze týkají pouze malých datových bloků; takže získáte jen rámcovou 
představu o rychlosti cache paměti disku a nevíte nic o větších datových blocích. Video využívá 
vyšší datové toky a pouze Disk Speed Test umožňuje spočítat i long burst data s přesnějšími 
výsledky. 

 

Chcete-li použít Disk Speed Test, počítejte s prohledáváním disku, takže doporučujeme 
zadávat správně hranice. Pokud je diskové pole testováno na 32 snímcích za sekundu u HD 
1080, neznamená to, že můžete snímat a přehrávat 29,97 HD, jelikož hranice je příliš blízko. Při 
kontrole výsledků sledujte 8 bit YUV 4:2:2 video sekce, jelikož Intensity Pro využívá 8 bitový, 
nekomprimovaný video formát. 

 

 
 
 

20 
 
 
 
 
 
 
 
 
 
 
 
 
Výsledky Disk Speed RAID po testu diskového pole. 

 
 
Sestavení nekomprimovaného diskového pole (PC)  

 
Pokud pracujete s nekomprimovaným HD videosignálem, interní harddisk není dostatečně 
rychlý. Potřebujete velmi rychlé diskové pole. To se dá koupit již připravené, nebo si je můžete 
sestavit ze dvou harddisků pro SD či alespoň z osmi harddisků pro HD. Prvním krokem je 
instalace a zapojení harddisků. 

 

Jestliže zamýšlíte používat diskové pole jako SW mix, musíte vypnout funkci ‘host RAID’. 
Nástrojem “Správa disků”, ve “Správě počítače” pod Windows™  nastavte software RAID, nebo 
se řiďte návodem výrobce nakonfigurovaného hardware pole RAID. 

 

Další informace získáte v Nápovědě a odborné pomoci pod Windows™. Projděte si sekci 
“Dynamické disky a svazky”. Tato sekce vám poskytne informace o krocích konfigurace 
diskového pole jako Strip. Kvůli prohledávání disku je při výpočtu datových toků, požadovaných 
pro váš diskový systém, je dobré přidat pro jistotu rozsah rychlostí pro případy výpadku rychlosti 
disku. Rychlosti disků se mohou zvýšit přidáním dalších disků. Serial ATA (SATA) disky mohou 
při zaplnění rychlost redukovat až na polovinu, takže 2-diskové SATA pole je vhodné zaměřit na 
100% safety margin. U 8-diskového SATA pole by tak mělo stačit 30% safety margin. Oběcně 
platí, že čím více je disků v poli, tím lépe. 

 

Pozn.: Přestože jiní výrobci a třetí strany mohou udávat různé hodnoty pro data u 
nekomprimovaného videa, výše uvedená doporučení jsou testována pro použití s Intensity Pro. 
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Správa disku. 



 

 

Blackmagic Design aplikace 
 
 
 
Použití Blackmagic Disk Speed Testu pro ov ěření disku ( Mac) 

 
Pokud chcete zkontrolovat rychlost diskového pole, spuštěním Blackmagic Disk Speed Testu 
získáte kontrolu rychlosti pole a získáte také výsledek v počtu snímků za sekundu. Je to velmi 
užitečné pro pochopení, jak různá disková pole pracují při snímání videa a přehrávání 
v různém video rozlišení a při různém počtu oken. 

 

Disk Speed Test nabízí přesnější výsledky pro velká disková pole, jelikož testy rychlosti, 
dodané výrobcem se namnoze týkají pouze malých datových bloků; takže získáte jen 
rámcovou představu o rychlosti cache paměti disku a nevíte nic o větších datových blocích. 
Video využívá vyšší datové toky a pouze Disk Speed Test umožňuje spočítat i long burst data 
s přesnějšími výsledky. 

 

Chcete-li použít Disk Speed Test, počítejte s prohledáváním disku, takže doporučujeme 
zadávat správně hranice. Pokud je diskové pole testováno na 32 snímcích za sekundu u HD 
1080, neznamená to, že můžete snímat a přehrávat 29,97 HD, jelikož hranice je příliš blízko. 
Při kontrole výsledků sledujte 8 bit YUV 4:2:2 video sekce, jelikož Intensity Pro využívá 8 
bitový, nekomprimovaný video formát. 

 
Výsledky Disk Speed RAID po testu diskového pole. 

 
 
 
Použití Apple Xserve RAID diskového pole  

 
Pokud pracujete s nekomprimovaným HD videosignálem, interní harddisk není dostatečně 
rychlý. V tom případě potřebujete velmi rychlé diskové pole, jako je Apple Xserve RAID. Apple 
Xserve RAID pracuje skvěle pro SD i HD, pokud je zcela zaplněn 14-ti disky a alespoň 512 MB 
RAM pro každý RAID kontroler. Pro maximální výkon a stabilní snímání i přehrávání 
nekomprimovaného videa doporučujeme následující nastavení: 

Check Use Controller Write Cache  

Uncheck Allow Host Cache Flushing  

Check Use Drive Write Cache  

Uncheck Use Steady Streaming Mode 
Nastavte “Read Prefetch” na 128 Stripes (8 MB/disk) – Pokud dochází k výpadkům 
oken nebo je video trhané, zkuste 8 Stripes (512 KB/disk), dle doporučení firmy Apple. 
Pozn.: Neexistuje jednotné nastavení pro všechny velikosti a druhy disků. 

Zde jsou nastavení, která jsme zjistili pro stabilní snímání a přehrávání nekomprimovaného 
videa. Jiná nastavení však mohou také dávat optimální výkon a proto doporučujeme vyzkoušet 
si to u vašeho prodejce, než změníte nastavení, pokud si nejste jisti, jak ovládání definovat. 
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Apple Xserve RAID preference. 
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Podporované formáty souborů 
 
 
 
Datové toky pro snímání a p řehrávání  

 
Datové toky pro nekomprimované video jsou poněkud vyšší a níže vidíte minimální doporučené 
požadavky na disk pro nekomprimované i komprimované video ve standard definition a high 
definition. Podporované standardy: HDTV 1080i/59.94, 1080i/50, 720p/59.94, 720p/50, NTSC and 
PAL. 

 
Komprimované video 
Standard Definition – Mac OS X 
Velikost okna MB za sekundu MB za minutu GB za hodinu 
720x486/29.97fps (NTSC) 4.6 275.4 16.1 
720x576/25fps (PAL) 4.6 275.4 16.1 
Standard Definition JPEG – Windows XP 
Velikost okna MB za sekundu MB za minutu GB za hodinu 
720x486/29.97fps (NTSC)* 5.1 306 17.93 
720x576/25fps (PAL)* 4.8 288 16.88 
High Definition DVCPro HD – Mac OS X 
1280x720p/59.94fps 14 837.9 49.1 
1920x1080/50i 14 837.9 49.1 
1920x1080/59.94i 14 837.9 49.1 
High Definition JPEG – Windows XP 
1280x720p/59.94fps* 5 300 17.58 
1920x1080/50i* 11 660 38.67 
1920x1080/59.94i* 13.19 791.21 46.36 
Nekomprimované video 
Standard Definition 4:2:2 
Velikost okna MB za sekundu MB za minutu GB za hodinu 
720x486/29.97fps (NTSC) 21.5 1288 75.5 
720x576/25fps (PAL) 21.2 1274.4 75 
High Definition 4:2:2 
1280x720p/59.94fps 106.8 6409.7 375.6 
1920x1080/50i 100.3 6020.5 352.8 
1920x1080/59.94i 120 7199.9 421.9 

 

* Typické hodnoty. 
 
Použití pro snímání a přehrávání 
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Problémy a potíže 
 
 
 
Použití Intensity Pro jako snímací a přehrávací karty je skvělé, ale také značně komplexní, 
díky nejrůznějším aplikacím. Rychlost datových toků videa je velmi vysoká, takže diskové pole, 
které používáte pro ukládání video nahrávky je mimořádně důležité, pokud se týká výkonu 
systému. Úplné informace o širokém rozsahu diskových polí a kompatibilních software aplikací 
je zcela mimo rozsah tohoto manuálu, nicméně jsou tři způsoby, jak získat více těchto 
informací. 

 

1.  Navštivte stránky Blackmagic Design www.blackmagic-design.com/support, kde jsou 
nejnovější informace o podpoře. Máme velký počet technických poznámek, reagujících na 
obecné dotazy. 

 

2.  Kontaktujte dealera. Váš dealer má nejnovější technické informace od Blackmagic Design 
a měl by být schopen vám poskytnout bezprostřední pomoc. Také doporučujeme 
prohlédnout si podmínky podpory, nabízené dealerem, poněvadž mohou obsahovat různé 
plány podpory, založené na požadavcích dle pracovních postupů. Váš dealer rovněž 
rozumí konfiguraci diskových polí a jelikož problémy s diskovými poli tvoří cca 90% otázek 
na NLE systémy podpory, váš dealer nebo dodavatel diskového pole bude schopen vám 
poskytnout odbornou pomoc. 

 

3.  Další možností je poslat email s otázkami. www.blackmagic-design.com/support/contact 
 

Pozn.: Prosíme, uveďte v dotazu co nejvíce informací ohledně vašeho technického problému 
a systémovou specifikaci, abychom mohli reprodukovat váš problém co nejrychleji. Dejte nám 
také vědět veškeré vaše postřehy ohledně dalších možných problémů, které se vám vyskytly, 
takže je můžeme v našich testovacích systémech realizovat, než odpovíme na email. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 
 
 
Použití pro snímání a přehrávání 
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Typické nastavení Intensity Pro  
 
 
 
Intensity Pro využívá HDMI pro připojení videokamer, televize a projektorů do počítače, 
s využitím populárních editačních a designových aplikací. Intensity Pro snímá video 
v reálném čase, přímo z HDMI výstupu na HDV kamerách a přehrává přímo do 
velkoplošných HDTV nebo HD projektorů, kvůli monitoringu a editaci. 
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Výstupy kamery 
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Zapojení do HDMI HDTV 
 
 
 
Tento příklad zobrazuje Intensity Pro, zapojenou do HDTV přes HDMI vstup. Propojte HDMI kabelem 
video výstup na kartě Intensity Pro a HDMI video vstup na HDTV, získáte high definition monitoring. 

 
 
 

 
HDTV s HDMI 
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Monitoring s využitím Intensity Pro 
 
 
 
Pokud využíváte velkoplošnou HDTV se vstupem HDMI, Intensity Pro můžete využít jako 
client-monitor ve formátech NTSC/PAL (4:3 a 16:9) nebo High Definition (1080i a 720p). 
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 Displej počítače 
 
 
 
 
 

 
 
 
 
 
 
 
 

 
 

 
 
 
 
 

 Displej počítače 
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Nastavení pro Blackmagic On-air 
 
 
 
Blackmagic On-Air je určený pro on-line video mix, využívající dvě karty Intensity. Tato aplikace 
umí živou editaci mezi dvěma HDV kamerami s možností záznamu na lokální disk nebo na 
externí diskové pole. 
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Snímání kompozitního videa z VHS přehrávače 
 
 
 
Pokud snímáte video z VHS páskového přehrávače, zapojte žlutý video výstup z přehrávače do 
zeleného Y vstupu u Intensity Pro. Zapojte bílý a červený audio výstup z VHS přehrávače do 
bílého a červeného audio vstupu u Intensity Pro. Pokud máte starý VHS přehrávač s jediným, 
mono audio výstupem, zapojte jej do některého audio vstupu u Intensity Pro nebo do audio 
splitter kabelu, který propojuje oba audio vstupy u Intensity Pro. Spusťte ovládací panel Intensity 
pod Windows, nebo System Preferences > Intensity pod Mac OS X. Proveďte nastavení vstupu 
pro NTSC/PAL (Y In) & Analog RCA Audio . Nyní můžete snímat video a audio z VHS 
páskového přehrávače. 

 
 
 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 

 
 
 
 
 
 
 

 
 

VHS přehrávač  
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Snímání komponentního videa z videokamery 
 
 
 
Pokud snímáte komponentní analogové video přes výstupní kabel z video kamery, zapojte 
červený, zelený a modrý výstup kamery do červeného, zeleného a modrého video vstupu 
u Intensity Pro. Zapojte bílý a červený audio výstup z kamery do bílého a červeného audio 
vstupu u Intensity Pro. Spusťte ovládací panel Intensity pod Windows, nebo System 
Preferences > Intensity pod Mac OS X. Proveďte nastavení vstupu pro Y, R-Y, B-Y Video & 
Analog RCA Audio . Nyní můžete snímat komponentní video a audio z videokamery. 

 
 
 
 
 
 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 

 
 
 
 
 
 
 

 
 

Kamera  
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Náhled komponentního videa v televizi 
 
 
 
Pokdu jde výstup komponentního analogového videa z Intensity Pro, zapojte červený, zelený 
a modrý výstup z Intensity Pro do červeného, zeleného a modrého video vstupu u televize. 
Zapojte bílý a červený audio výstup z Intensity Pro do bílého a červeného audio vstupu 
u televize nebo do zesilovače. Spusťte ovládací panel Intensity pod Windows, nebo System 
Preferences > Intensity pod Mac OS X. Proveďte nastavení výstupu pro HDMI & Y, R-Y, B-Y . 
Nyní můžete sledovat komponentní video a audio na televizi. 
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Zapojení Intensity Pro  
 
 
 
Intensity Pro je vybavena vysoce kvalitními, analogovými, komponentními konektory typu RCA  
a HDMI pro širokou nabídku videokamer, televizí a projektorů. Intensity Pro snímá video 
v reálném čase, přímo z HDMI nebo z analogových, komponentních výstupů HDV kamer. Pro 
přehrávání v reálném čase, v rámci client-monitoringu a editace použijte velkoplošnou HDTV 
nebo HD projektor přes HDMI nebo analogové, komponentní výstupy. 
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Zapojení Intensity Pro přes NTSC/PAL  
 
 
 
Vysoce kvalitní analogové, komponentní konektory Intensity Pro typu RCA můžete využít 
i pro snímání a přehrávání kompozitního videa přes NTSC/PAL. Jednoduše zapojte běžné 
RCA kabely do breakout kabelu Intensity Pro, dle konfigurace na obrázku. 
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NTSC/PAL  
 

 
R-Y Input 

 
Output Y Input 

 
B-Y Input 

 
R-Y Output 

 
Input Y Output 

 
B-Y Output 

 

(L) Audio Input 
(unbalanced analog) 
(R) Audio Input 
(unbalanced analog) 
(L) Audio Output 
(unbalanced analog) 
(R) Audio Output 
(unbalanced analog) 

 

SPDIF/AES Output 

 
Nastavte vstup a výstup. 
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Zapojení Intensity Pro přes S-Video 
 
 
 
Vysoce kvalitní analogové, komponentní konektory Intensity Pro typu RCA můžete využít i pro 
snímání a přehrávání S-videa pomocí kabelu s redukcí S-video to RCA, dle obrázku níže. 

 
 
 
 

S-Video vstup  33 
 
 

R-Y Input 
 

Y Input 
 
 

S-Video 
B-Y Input 
 
R-Y Output 

 
Y Output 

 
B-Y Output  

Nastavte vstup. 
 
 
 

S-Video výstup  
 
 

R-Y Input 
 

Y Input 
 

B-Y Input 
 

R-Y Output 
 

Y Output 
 

S-Video B-Y Output  
Nastavte výstup. 
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Dvouletá Záruční lhůta 
 
 
 
Blackmagic Design zaručuje, že tento produkt nebude mít žádné defekty v materiálech 
a řemeslné práci, po dobu 24 měsíců od data zakoupení. Jestliže se u něj projeví závada během 
této Záruční doby, Blackmagic Design, v rámci podmínek, buď nechá opravit vadný produkt 
zdarma, nebo jej vymění za jiný. 

 
Abyste měli nárok na záruční opravu, musí zákazník upozornit dealera Blackmagic Design na 
závadu ještě před vypršením Záruční doby a splnit veškeré požadavky, dané Záručními 
podmínkami. Zákazník je odpovědný za zabalení a dopravu vadného produktu do autorizovaného 
servisního střediska, určeného dealerem Blackmagic Design, včetně uhrazení dopravy. Zákazník 
odpovídá za platbu všech dopravních nákladů, pojištění, sazeb, DPH a dalších poplatků za 
vrácení produktu z libovolného jiného důvodu. 

 
Tato Záruka se nevztahuje na žádné poškození, závadu nebo zničení, způsobené nesprávným 
použitím nebo nesprávnou či neadekvátní údržbou a péčí. Blackmagic Design nenese 
odpovědnost za poskytování záručního servisu, pokud jde: a) o opravu poškození, vzniklého díky 
osobě, jiné než pověřené Blackmagic Design k instalaci, opravě nebo servisu produktu, b) o 
opravu poškození, vzniklého nesprávným použitím nebo zapojením do nekompatibilního zařízení, 
c) o opravu poškození či závady, způsobené použitím non Blackmagic Design součástí či 
doplňků, nebo d) o servis produktu, který byl upraven či integrován s jinými produkty, jestliže se 
v důsledku této úpravy či integrace prodloužila doba opravy nebo vznikly potíže se servisem 
produktu. TATO ZÁRUKA, DANÁ ZE STRANY BLACKMAGIC DESIGN MÍSTOPŘÍSEŽNĚ, SE 
NEVZTAHUJE NA ŽÁDNÉ JINÉ ZÁRUKY, EXPRESNÍ ČI IMPLICITNÍ. BLACKMAGIC DESIGN A 
JEJÍ DEALEŘI ODMÍTAJÍ JAKOUKOLIV IMPLICITNÍ ZÁRUKU PRODEJNOSTI ČI STAVU PRO 
KONKRÉTNÍ VYUŽITÍ. ODPOVĚDNOST BLACKMAGIC DESIGN ZA OPRAVU NEBO VÝMĚNU 
VADNÝCH PRODUKTŮ, JE CELKOVÉ A VÝHRADNÍ OPATŘENÍ, DANÉ ZÁKAZNÍKOVI NA 
NEPŘÍMÉ, SPECIÁLNÍ, NÁHODNÉ NEBO SOUVISEJÍCÍ POŠKOZENÍ, BEZ OHLEDU NA TO, 
ZDA WETHER BLACKMAGIC DESIGN NEBO DEALER UPOZORNIL NA MOŽNOST 
TAKOVÉHO POŠKOZENÍ. BLACKMAGIC DESIGN NENESE ODPOVĚDNOST ZA JAKÉKOLIV 
NELEGÁLNÍ POUŽITÍ ZAŘÍZENÍ ZÁKAZNÍKEM. BLACKMAGIC NENÍ ROVNĚŽ ODPOVĚDNÝ 
ZA JAKÁKOLIV POŠKOZENÍ, VZNIKLÁ POUŽITÍM TOHOTO PRODUKTU. UŽIVATEL 
PRACUJE S PRODUKTEM NA VLASTNÍ ODPOVĚDNOST. 

 
COPYRIGHT 2006 BLACKMAGIC DESIGN. VEŠKERÁ PRÁVA VYHRAZENA. ‘BLACKMAGIC 
DESIGN’, ‘DECKLINK’, ‘HDLINK’, ‘WORKGROUP VIDEOHUB’, ‘MULTIBRIDGE’, 
‘MULTIBRIDGE EXTREME’, ‘INTENSITY’ A ‘LEADING THE CREATIVE VIDEO REVOLUTION’ 
JSOU REGISTROVANÉ OBCHODNÍ ZNÁMKY V US A DALŠÍCH ZEMÍCH. VEŠKERÁ OSTATNÍ 
JMÉNA SPOLEČNOSTÍ A PRODUKTŮ MOHOU BÝT OBCHODNÍMI ZNÁMKAMI JEJICH 
MAJITELŮ A SPOLEČNOSTÍ, KTERÉ JSOU S NIMI SPOJENY. 
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